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SECTION 8 - PEGASUS MAIL

What is Pmail?
How do I send a message?
What is an address book?
How do I send a message to several people?
How do I manage my mail?
How do I print a mail message?
How do I send an attachment?
How do I open an attachment?

⇒ WHAT IS ELECTRONIC MAIL?

Electronic mail, or ‘email’, combines the advantages of the telephone and the letter.  It enables you to
send a message from your computer to a friend or colleague on any other computer anywhere else in
the world, provided only that both computers are connected over a common network.   Email can be
almost as quick as a telephone call, but like a letter it waits in an electronic mailbox until its recipient
is ready to read it, and can be kept in the electronic mailbox as a permanent record.

⇒ STARTING PEGASUS MAIL

• Locate and then double-click on the Pegasus Mail icon.

You will presented with a window like this:
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The three most important buttons you will need to know at the moment are:

• Compose a new mail message 

• Read New Mail  

• Open saved mail folders 

⇒ SENDING A MESSAGE

• When you wish to write a new message click on the Compose a new mail message button on the
tool bar in the main Pegasus window

You will be presented with the following blank message:

• click with the left mouse button in the To: box
• type the email address such as: quip@ed.ac.uk

This is a test address which will send email back to you.

• click in the Subject box.
• type the subject line: this is a test
• click once in the large white box. This is where the text of your message is typed.
• type up a short piece of text.

Note:  Don’t type anything in the Cc: box for now.

• click on the send button.

⇒ READING NEW MAIL

• click the Read new mail button.   
      you will see the summary for the New Mail folder.
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• Double-click on the message you wish to read.
       A window will open showing the contents of the message.

The To:, From:, Date sent:, and Subject: fields are shown at the top of the message followed by the
text.

The Next and Previous buttons allow you to read the contents of other new messages in the new mail
folder.

Return To the Summary Window
• click on the button marked with an ‘X’ at the top right of the message window above to close.
• The read messages will now have a tick next to them.
• These messages will move to the Main Folder when you return to the main Pegasus window.

Leaving the New Mail Folder
• Double-click on the close-window box at the top right of the New Mail window.

Note: check that you have closed all open message windows, the folder will not close otherwise.

⇒ REPLYING TO MESSAGES

• If the message you wish to reply to is not open then click on the Mail Folders button to see the
list of available folders.

• Select the folder containing the message you wish to reply to.
• Select the message you are replying to by clicking on it once.
 

• Click the reply button  .

The following window should appear :-
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• Clicking on OK ensures that the original message is marked by > characters at the start of each
line and is included in the reply.

• The dialogue box also allows you to reply to one or more people, depending on whether or not the
original message was sent to a list of people or not.

• Note Pmail will not copy the original message into reply unless include original message.. box
has been ticked

⇒ FORWARDING A MESSAGE

• Select the message you wish to forward
• click the Forward button. A dialogue box should appear

• Type the email address you wish to forward to (or alternatively use your address book)
• check the box saying Edit before sending and click OK.
• Edit the message accordingly
• Send

⇒ ADDRESS BOOKS

Pegasus mail allows you to store peoples email addresses in address books. These can be created for
your own personal use. They store the full email address of each person and an alias or nickname that
you use to reference them.

The contents of the Edinburgh Directory are already installed in the Pegasus address books for
convenience.
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• click on the Address Books button  
• select and open an address book.
• click anywhere in the white area of this dialogue box and type in the first few letters of the name

you are looking for.

To send a message to that person:

• Double-click on the name in the address book. A new message window opens with the To: field
completed.

 
• Note if you already have the new message window open, with the cursor in the To: field or the

Cc: field, clicking the Paste To button in the address book copies the address to that field.

• Click on Close to close the Address book.

Creating address books
You can create any number of your own address books.  This can be done by selecting New from the
address books window

• Click on the Address books button in the main Pegasus window. 
• Click on the New button. A dialogue box appears.
• Type the name you wish to give your address book  in the Long name for item box.  This is the

name that will appear in the list of address books.  If a Filename isn’t given the Pegasus mail
generates a standard filename.

• Click OK to create the address book.

Add a New Address Book
• Double-click on the name of the newly created address book

• Click on the Add button ;   a dialogue box should appear.
• Complete the details and click OK. It is only necessary to use Name, Key and the email address.

Key is optional.

⇒ SEND A MESSAGE TO SEVERAL PEOPLE

There a number of ways of doing this:-

Using the To: field
• Click on the Compose a new mail message button
• Put at least two addresses in the To: field and separate them by a comma
• Send the message.

Using the Cc: field
• click on the Compose a new mail message button
• Address the message to one person
• Type the names you wish the message to be copied to in the Cc: field.
• Send the message

Create a Distribution List

• click on the Distribution lists button   
• click on New List
• give your list a name in the dialogue box ‘long name for distribution.  Also give it a filename no

longer than eight characters.  Click on OK.
• Highlight this new list by using the mouse to click on it once.  Note : it may already be

highlighted if so there is no need to click on it again.



Section 8:  Pmail
Release No 2. April 2000

• click on the Edit button to add addresses to the list
• put a useful name in the To: field.  This is the name that people on the list will see when your

send a message to the list.  If you don’t give a name the full list of addresses will be copied to the
To: field.

• type in the email names that are to be in the list in the bottom half of the window (only one per
line). Click on Save.

Note: You will only be able to edit the Distribution Lists that you have created, these will be black in
colour when displayed. They will also only be available to you and are not system wide lists accessible
to everyone.

⇒ MANAGING MAIL

Keeping your mail messages in a range of mail folders allows you to manage them easier.

Moving Messages
• Display the Main folder
• Select the message you wish to move
• click on the Move button
• Pegasus displays a list of all available folders. Double click on the folder you wish your message

to move to.

Creating a Folder

• Click New to create a new folder.
• You will be asked for a name. This can be any length
• Type the name you wish to call it then click OK.
• Your new folder will be displayed in the window. Move the selected messages into that folder as

shown previously.

Searching for Messages
• Select Find text in the Edit menu. The following should appear:-
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• Type the text you want and decide where to look i.e. all folders or a selected folder. and click OK
• All the messages containing the word you specified will be listed for you to select one.

Once a folder is opened a second set of options appears in the Folders Menu. The second group of
entries allow you to specify how the folder should be sorted. The default for folders is Sort by date.
A check mark appears next to the entry which indicates how the folder is currently sorted.

• Sorting by subject: allows you to sub-sort either by date or by reverse date.
• Sort unread before read: this splits the folder into two groups of messages - those which have

been read and those which have not. (All  of your unread mail appears above the read mail in the
list.)

• Sort by colour: use the Set colour option on the menu to display your messages in any of 15
colours, then use "sort by colour" to group them together, sub-sorted by date. (You can also set a
message's colour using the Highlight action in your new mail filtering rules).

The section header panels in the folder window are buttons which can also be
clicked to select a sort order.

You can sort by reverse date by holding down Ctrl as you click on the Date/time
or Subject buttons.

WinPMail remembers the sorting option you select from session to session.

⇒ TRAYS

A Tray is a specialised type of folder which can contain other folders or trays, but NOT messages.
Trays allow you to organise all of your folders i.e. you can keep folders dealing with similar topics in
one tray.

Creating a Tray
• Open the Select a folder dialogue box by clicking the Mail folders button
• Click on the New button
• Pegasus will ask for the name of the new folder or tray. Type in a name e.g. newsletters
• Check the filing tray box instead of message folder.
• Click OK
• A tray icon appears in the folders window.
• Open the tray by clicking on it. Note the icon changes but no new window opens.
• Click the New button to create a folder within the tray
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• Type the new folder name and click OK

Note. The tray has to be open to enable you to create a folder within it.

Move Messages as a Group
• Select a few messages from your main folder
• Click on the Move button
• Open the Tray that has just been created
• Double click on the folder that was made within the tray

You are automatically returned to the Main Folder but the selected messages have disappeared. They
have been placed in the new folder within the Tray.

⇒ PRINTING

• Open the Main Folder
• Select a message
• Select Print from the file menu. This will send the message to the printer.

⇒ SAVING MESSAGES
• Open the message you wish to save
• Select Save message to file from the Reader menu.
       (this menu only appears when a message is open)
• An ‘export to which file?’  dialogue box will be displayed
• Select the appropriate directory and folder then type filename and click OK
• The contents of the message will be saved to that file

⇒ ATTACHING FILES

This is a useful option to have if you have a file that is not purely plain text, for example it may be an
excel file or it may contain graphics and diagrams. The file Attachment option allows these files to be
encoded then sent via email and translated at the other end.

• Click the Send Mail to start a new message
• Address the message
• Click the attachments tab or press F7 to attach a file
• The attach dialogue box should appear
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• Click on the ‘Add attachment’ button, then select the file you want to attach by moving through
the directories and clicking on the file name.

• Click on the ‘Open’ button - the selected file should now appear under ‘current attachments’
Click on the ‘message’ tab or press F8 to return to your message.

 Reading an Attached File
• A message that has an attachment should appear in your mailbox marked with a bullet
• If the file is readable, you can click on the view button to read it. If it is a graphics file save to disc

then use a graphics file to view it.
• The easiest way to look at the file is to click on the Save button and save it to your H:\ drive and

then open it from there.

⇒ THE FILE MENU

File/New...   or <ctrl>+N
Opens a window that allows you to write and send a new message.

File/Open saved message
Opens the file containing your saved messages.
File/Read new mail or <ctrl>+W
Allows you to read your new mail

File/Mail Folders   or <ctrl>+L
Opens your saved mail folders

File/Noticeboards 
The noticeboards contain saved messages which both you and other people can read.  Clicking on this
icon opens up the Noticeboard.

A noticeboard may contain notices, which you can read by pressing  <Enter> (the same way as in a
mail folder), and can also contain other noticeboards. If you double-click on a noticeboard entry,
Pegasus Mail will open that noticeboard and show its contents in the list.  If you have opened a
noticeboard, then there will always be a special entry at the top of the list marked .., which will take
you back to the parent noticeboard.
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If you are permitted to post notices in the current noticeboard, then the text Post will appear next to
the topic's entry in the list: in a read-only topic you may only read the message, not add or delete
them.

Posting a Notice:- This is a simplified version of posting a mail message - you only have
to enter a subject and then type in your notice. Pegasus Mail automatically supplies the name of the
noticeboard in which the notice is to be placed.

You can add attachments to it in exactly the same way as you would to a mail message, by clicking the
Attachments button or by pressing <F7>.

To finish your notice and post it to the noticeboard, click Send or press <Ctrl+Enter>.  Your notice
will appear on the noticeboard immediately.

⇒ FILE/NETWORK CONFIGURATION

This allows you to change the way that Pegasus works and looks. If you click on tools, you will see the
following list of options :-

Sending Mails :
- allows you to enter the organisation you work for, and to choose whether files will be sent as
attachments or enclosed in the main message. You may also select your return address.

Toolbars :
- allows you to specify whether you want the button panel in the main window to be shown as a h
horizontal floating window, a vertical floating window, or a fixed toolbar under the window menu.

Hyperlinks :
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- Pegasus Mail can detect URL’s (Uniform Resource Locators), or hypertext links for the world wide
web in your messages.  When it finds a valid HTTP in a mail message it highlights it by displaying it
in underlined green.  Double clicking on this link will automatically open up Netscape Browser for
you.

General Settings :
- allows you to choose such options as what to do on starting up, whether to confirm deletion of
messages, and whether to encrypt your own copies of the messages you send in encrypted form.

Home mailbox location :
- This allows you to tell Pegasus where to keep your messages and related files. But do not change just
leave the settings as they were when they were installed.

Message Settings :-

This allows you to automatically set the above options .

 Reader Settings :
- allows you read your new messages in a preferred format.

Signatures :
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- these are small amounts of text that are automatically placed at the end of your message and usually
include your name, job title, address, telephone number and email address.
You can define several different signatures, depending on where the message is going.

File/Print   or <ctrl>+P
This command will enable you to print directly to a selected printer. Usually selected in Printer set-
up.

File/Exit
Exits from Pegasus Mail.

The following aren’t really applicable to the Library mail system as it is all configured for sending
mail via the Network automatically.

File/Check host for new mail  
Tells WinPMail to connect to your POP3 remote mailbox and download any mail waiting there.

File/Selective mail download

File/Send all queued mail  :
Tells WinPMail to process all mail currently in your outgoing mail queue and send it to your relay
host using the SMTP protocol.

File/Check and send mail  
Has the same effect as selecting both the options described above in a single connection.

File/Review queued mail
Allows you to examine and change mail in your mail queue waiting to be sent. You can edit queued
mail any time up to the point when Pegasus Mail actually attempts to send it.

⇒ THE EDIT MENU

Edit/Undo or <ctrl>+Z
Undo stores the previous state of the message before the most recent action.  This allows you to rectify
a mistake.

Edit/Cut   or <ctrl>+X
This cuts the select pieces of text and places it in clipboard, where it can be pasted elsewhere or in
another software package.

Edit/Copy   or <ctrl>+C
This command copies any selected text into the clipboard, from which they can be pasted elsewhere or
in another software package.

Edit/Paste   or <ctrl>+V
This pastes any text that has been sent to the clipboard by cutting or copying from a message or from
another software package.

Edit/Clear
Clears the screen of the following:
• Selection
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• All

Edit/Find Text or <ctrl>+F
This option allows you to search the contents of the current folder for a piece of text. Type the text you
want to look for in the editing field. The text can contain * and ? wildcard characters.

Edit/Find and replace or <ctrl>+R
Once you have found the piece of text or word you are looking for this option allows you to replace it
with another phrase or piece of text.

Edit/Find/Replace again or <ctrl>+G
This option repeats the previous two options for you.

Edit/Select All or <ctrl>+A
This allows you to select all of the text in the message. Or indeed all of the messages in a folder,
allowing you to alter or delete as appropriate.

The Addresses Menu

Addresses/Local users     or F2
Allows you to look up email addresses of users on your server.

Addresses/Address books     or F3
This allows you to open up your address books and also the Edinburgh Directory.

Addresses/Logged in Users or F4
This function allows you to see who is logged on to the system and obtain their address also letting
you email them directly after clicking on their name.

Addresses/Distribution lists     or F6
This allows access to the Distribution List manager, where you can create edit and use existing lists.

⇒ THE TOOLS MENU

Tools/Options or shift + F10
This command takes you to the general settings menu as explained previously.

Tools/Extensions
This allows a number of options such as:
• Business cards - this option allows you to generate a personal or professional business card in

three different formats.
• Mail merge - which lets you create personalised mail messages using a data file and a format file
 
• Order Manuals

• Telephone messenger or   allows you to email mail someone alerting them to the fact that
they received a telephone call. You can give details of who called, the time they called and any
message that was taken.

• Mail Filtering Rules  or   Pegasus Mail allows you to perform automated processing of mail
when messages matching particular conditions are met.  You might use this, for example, to
move all "confirmation of reading" replies from the current folder to another folder -- in this case,
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the condition for which you would test would be the first 4 characters of the "Subject" field being
"RCPT". Pegasus Mail can provide this automated processing in the following situations --

- Automatic filtering when the new mail folder is opened or closed
- Filtering your copies to self
- Using rules to filter the contents of any folder

• Glossary
WinPMail allows you to store abbreviations for commonly-used text strings which  you can expand at
any time with a single keystroke. To create a glossary entry, choose Edit/create from the Glossary
submenu of the Edit menu.

⇒ THE FOLDERS MENU

When you select Mail folders from the File menu, or click the Folder icon on the toolbar, the Folder
Manager window opens.  This window lists all the folders and trays you have created and can be left
open on your desktop while you run the program.

While the Folder Manager is open, you can drag messages from any folder window and drop them
onto any folder entry it contains.  You cannot drag messages onto a tray entry because trays can only
contain folders and other trays.

• Folder/Reindex Folders
From time to time, a folder's index file may become corrupt, which can result in errors when you
attempt to open it. If this happens, highlight the folder then click the right mouse button and select
reindex folder

• Folder/Check consistency
This checks the folder for any problems This option attempts to verify that a folder is intact and is
accessed by highlighting the folder and clicking the right mouse button

• Folder/Cut folder
This option allows you to cut a message or messages from one folder and moves them to clipboard
until you wish to paste them in to another folder, or another tray.
 
• Folder/Paste folder
Select this if you want to move a folder or tray to another tray. The highlighted folder or tray will be
removed from the list and information about it will be saved in a disk file (called TRAYSAVE.PM) in
your home mailbox. Once you have chosen the Cut folder
 
• Folder/Compress folder
When you delete a message from a folder, Pegasus Mail does not immediately reclaim the space it
occupies; instead, it waits until you have deleted around 20000 characters from the folder then
recovers all the space in a single pass.

• Folder/Font
The last entry on the menu allows you to select the font the folder window will use to display the list.
This setting is global to all folders and is remembered from session to session.

Once a folder is opened a second set of options appears in the Folders Menu. The second group of
entries allow you to specify how the folder should be sorted. The default for folders is Sort by date.
A check mark appears next to the entry which indicates how the folder is currently sorted.

• Sorting by subject:
allows you to sub-sort either by date or by reverse date.

• Sort unread before read:
this splits the folder into two groups of messages - those which have been read and those which have
not. (All  of your unread mail appears above read mail in the list.)
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• Sort by colour:
use the Set colour option on the menu to display your messages in any of 15 colours, then use "sort by
colour" to group them together, sub-sorted by date. (You can also set a message's colour using the
Highlight action in your new mail filtering rules).

The section header panels in the folder window are buttons which can also be
clicked to select a sort order.

You can sort by reverse date by holding down Ctrl as you click on the Date/time
or Subject buttons.

WinPMail remembers the sorting option you select from session to session.


